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INTRODUCTION

This tutorial guide is an introduction to digital logic synthesis using the Synopsys and Xilinx
tools. You should hee working knavledge of the UNIX operating system (usingtteditors,
copying files, creating directories, printing, etc.). Kuedge of the VHDL language is not
required to complete this tutorial. The VHDL code feery example has been included. The
examples hae been kpt simple, the focus is on using the tools rather than learnimgcharite
VHDL code. There are mgriine books dealing with VHDL. There are not mdmoks con-
cerning the use of synthesis tools. This tutorial attempts to bridgepheetiveen the nace
userss knawledge of such tools and the documentatizailable from the toolendors. This
tutorialis notmeantasa definitive guideto thetools, ratherit gentlyintroducesthe studento the
mary facets of the tool. It is hoped that afteving completed the material contained in this
guide that the on-lineendor documentation will not appear as foreboding and intimidating.

The tutorial is drided into four parts. &t | deals with VHDL simulation using the Synopsys
VHDL System simulator (VSS). & Il focuses on logic synthesis; the Synopsys Design Com-
piler and Design Analyzer being the tools of choice. Design Compiler shell scrptbéden
usedratherthanthealternatve DesignAnalyzerGraphicalUserinterfacemethodof synthesizing

a design. This conscious decisioashbased upon the a@mience of shell scripts: thenay be
executed from the command line (e&ting the need for a graphicorkstation terminal) and

they may readily modified for other designsar®lll concerns itself with implementation using
theXilinx DesignManager In thissectionthenetlistfile obtainedasaresultof thesynthesistep
(performed in Brt II) is corverted into plsical hardvare which (hopefully) functions correctly
The last part (&t IV) gives details of the Xilinx FPGA demonstration board. This is the board
which will be used to program and test the field-programanditeayray

Thedesignsn thistutorial weresynthesizedisingSynopsyss DesignCompilerVersion3.4band
Xilinx’ s Alliance M1.3 softwre.



PART | : VHDL Simulation using SYNOPSY S

This section explains the use of the Synopsys tools to perform simulation of source code written
inthe VHDL langauge. Several examples will illustrate various aspects of the different tools
available. Most of the tools are available in command-line version and aso in graphical-user
interface mode. While more information can be generated and absorbed by the user in graphical
mode, the use of the command line version allows remotely accessing and using the toolsviaa
modem connection.

|. Setting up the user environment to run the Synopsys VHDL simulation tools

Prior to running the Synopsys tools, it is necessary to set up your UNIX computer account. Per-
form the following from your UNIX prompt. In the following, the % symbol refersto the UNIX
prompt, your prompt may be different.

Step 1:
% source /CMC/ENVIRONMENT/synopsys.env

Alternatively, once may copy the file/CMC/ENVIRONMENT/synopsys.env to one's home
directory and source it from there (make sure you have the most recent version of thefile):

% cd
% cp /CMC/ENVIRONMENT/synopsys.env .
% source synopsys.env

Step 2:

The Synopsystools requires several setup filesin order to function properly. In order to perform
VHDL simulation, afile named .synopsys vss.setup is needed. There are three locations for this
file:

(i) the default system setup file found in the Synopsys installation directory which in our current
setup is/CM C/tool §/synopsys/syn/admin/setup/.synopsys_Vvss.setup

(i1) the user’s home directory
(iii) the current working directory.

The Synopsys tools read the required setup filesin the above specified order. Each successive re-
reading will override any previous settings found in a previously read file. For our purposes, it is
simplest to create a.synopsys_vss.setup file in aworking directory from which we will invoke the
simulation tools from. We will first create a directory called Synopys, and within this directory a
subdirectory called Code will be created. The Code subdirectory will be used to contain the
VHDL code to be ssimulated, the .synopsys_vss.setup file, and adirectory called Work (which will



be used to hold intermediate files created by the simulation tools). Figure 1 illustrates the direc-
tory hierarchy which will be created.

/home/user_name

I
I
| Synopsys
I
I
| Code
I

.SyNOpSys_VsS.Setup

|
L
|
|
| Work

Figure 1: Directory hierarchy for VHDL Simulation using Synopsys.
I ssue the following commands from the UNIX prompt:

% cd

% mkdir Synopsys

% cd Synopsys

% mkdir Code

% cd Code

% mkdir Work

% cp /CMC/ENVIRONMENT/.synopsys _vss.setup .

This sequence of commands will create the Synopsys directory, the Code subdirectory, the
Work subdirectory and will copy the required setup file to the Code subdirectory. Examine the
contents of the .synopsys_vss.setup file. It contains three lines of text:

WORK > DEFAULT
DEFAULT: ./Work
TIMEBASE = NS

Thefirst two linestell the Synopsystoolsthat thelogical library named WORK should be mapped
to the physical UNIX directory called ./Work. The. is UNIX shorthand notation for the current
directory. Thelast line sets the default timebase to nanoseconds. You need not concern yourself
further with thisfile.

This completes the setup for perfroming VHDL simulation using the Synopsystools. In the next



sectionwewill presensereralexampleson how to usethe Synopsysoolsto performVHDL sim-
ulation.

II. Performing VHDL simulation using Synopsys

This section will illustrate the use of the Synopsys tools used to perform VHDL simulation. The
examples will illustrate a&rious features of the tools.

Example 1: Simulating a 2-input ANDate (using the Graphical User Intesé).

(1) Change into your Synopsys/Code directory and create a file called and2.vhd with the follo
ing contents:

entity and2 gate is

port( in_1, in_2: in bit;
out put : out bit);

end;

architecture exanple of and2 gate is
begi n

output <=in_1 and in_2;
end;

You canuseary UNIX text editor( vi, emacsxedit, etc)to createandsave thisfile. Thenext step

is to “analyze” the VHDL source file. This is a process similar to compiling source code written
in a high-level programming language such a C or HBRN. During analysis of VHDL code,

ary syntactical errors will be reported.

There are tw Synopsys tools used to analyze VHDL code. The first is odlidi@n, and is the
command line grsion. This means that vhdlan can b®ked through a modem connection.

(2) Analyze the and2.vhd file usingdlan.
% vhdlan and2.vhd

A smallmessaggiving the versionnumberof thetool will bedisplayedandyouwill bereturned
to the UNIX prompt if your code contains no syntax code. A typical sessiowhdthn is as
given belov:

ted@dea Code 3:57pm >vhdlan and2.vhd
Synopsys 1076 VHDL Analyzerevsion 3.4b

Copright (c) 1990-1995 by Synopsys, Inc.
ALL RIGHTS RESEED
This program is proprietary and confidential information



of Synopsys, Inc. and may be used and disclosed only as
authorized in a license agreement controlling such use
and disclosure.

ted@dea Code 4:06pm >

If therearesyntacticakrrorsin thesourcecode,vhdlanwill reporttheline numberandattempto
describe the source of the errdor example, suppose that in the line port(in_1, in_2: in bit; the
word bit was misspelled as bitt:

ted@dea Code 4:11pm >vhdlan and2.vhd
Synopsys 1076 VHDL Analyzerévsion 3.4b

Cowright (c) 1990-1995 by Synopsys, Inc.
ALL RIGHTS RESEED
This program is proprietary and confidential information
of Synopsys, Inc. and may be used and disclosed only as
authorized in a license agreement controlling such use
and disclosure.

port(in_1, in_2:in bitt;
N

**Error: vhdlan,575 and2.vhd(2):
BITT is not declared.

“and2.vhd”: errors: 1; arnings: 0.

ted@dea Code 4:11pm >

Vhdlan reports the line number which the error(s) occur(s) enclosed in parenthesesddhe
file name. In this case, there is an error in line 2 of the file and2.vhd.

(3) Analysis may also be performed usgvgn, which is the graphical-usanterface equialent
of vhdlan. In order to use @n, one must be sititng in front of a graphiagkstation.

% gvan and2.vhd

Asin thecasepf vhdlan,gvanwill performits work andreturnto the UNIX promptin thecaseof
no errors in the input file. If you change into therlWsubdirectoryyou will see that tw files
were created as a result of performing analysis. In Xaisple the tw files are named
AND2_GATE.mra and AND2_GAE.sim. Had we not told Synopsys (through the
.Synopsys_vss.settite) to storethesefiles in the Work subdirectorythetool would have created
them in the directory from which the commanadsarvoked from.

In the case where the source file contains errors, an X-windlbbe opened on your display (



see Figure 2). Any errors contained in the source code will be displayed in the central portion of
the window. One may choose to correct the error by selecting with the left mouse button the Edit
button found at the bottom of the window. Thiswill open anew window with the vi editor
invoked upon thefile in question. Alternatively, one may exit gvan (by selecting Cancel) and edit
the offending line using any available text editor.

FJ "and2,vhd": errorst 1t warnings: 0,

f

= [

File: and2.vhd Line; 2

A [rort? in 1, in_2s in bitt:

P

pekErar: whdlan, 575 ande,whd (2 :
BITT iz mot declared,
"and?,vhd": errarzy 1 warningz: 0,

- |

] |~
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Figure 2: Gvan window containing error messages.

(4) Thenext stepisto simulatethe VHDL model. Thisisdone with the vhdldbx command. This
command will invoke the graphical VHDL debugger tool. From the UNIX prompt enter:
% vhdldbx &

The ampersand character (&) will cause the system to return you to your UNIX prompt after the



vhdldbx window appears (see Figure 3).

Library Dle=ign
= -~ |AoDa__RT1
SYMOPSYS AWDZ_GATE__EXAMPLE
IEEE COUMTZE__RTL
IEEE_RSIC HALF _ADDEFR__COMCURREMNT
COMDISCO_MYLA LABL__TED
GTECH LED__TEST
GSCOMP SEVEMSEG__COMCLURRENT
7 WITAL K TEST_COUMTER__TEST
[ I I~

Dezign LQEFHULT+HHD2_GHTE__EKHMPLE

Time Units NS

Arguments

jﬁﬂ Eancell

Figure 3: Vhdldbx window.

Take amoment to examine thiswindow. The Library scrollbox containsalist of libraries. The
default library is set to DEFAULT. If you recall, this library was mapped to the logical library
called WORK which was mapped to the physical directory .Work. Thiswas accomplished with
the .synopsys_vss.setup file. When vhdlbx isinvoked, the tool searches the selected library and
will list in the design scrollbox the names of any entity-architecture pairs using the format
entityname__architecturename. In my Work library, | had many compiled entity-architecture
pairs, hence the long list. You should only see one listed: AND2_GATE__ EXAMPLE. Select
this design with the left mouse button.

The Time Units button is used to select the time unit used during the running of the simulation.
Its value may be atered by selecting a different value from the list which will appear when this
button is selected. To invoke the simulator, select the OK button. The Synopsys VHDL Debugger
(Vhdldbx) window will appear as shown in Figure 4. Thiswindow contains the source code of
the current working region being simulated (more on the concept of current working regionin a
later section of thistutorial). At the bottom of the window isacommand window where simul ator
commands may be entered manually. The # symbol designates the simulator prompt. In the cen-
tral portion of the window, the current value of the simulation time is listed.
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Figure 4: Synopsys VHDL Debugger (Vhdldbx) window.

(5) One can manually assign values to signals using the trace and assign commands. The trace
command will cause the signal which isto be traced to be listed in awaveform window. The
assign command is used to set asignal to acertain value. For example, we wish to have the values
of thethree signalsin_1, in_2, and output appear in the waveform window. To do so we would
issue the following commands from the command window of the Debugger window (see Figure
5):

#tracein 1
#tracein 2
# trace output

Alternatively, one may list al signalsto be traced on asingle line separated by one or more blank
Spaces:



#tracein_1in_2 output
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& ; ;
1 entity and?_gate is
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K output 1 out bitrs:
4 end:
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Figure 5: Issueing a trace command from the command window in V hdldbx.

After entering this command, the system may report that it is builing a cache for the fonts direc-
tory. Be patient this may take some time on slow machines. This cacheis built only once, future
simulations will refer to this fonts cache directory. You will seelisted in the Debugger window
the following messages:

#tracein 1

stlpatch: Can’'t write to temporary
stlpatch: Error O

stlpatch: Can’'t write to temporary
stlpatch: Error O

#



Ignorethestlpatch:messagesAfter awhile, the SynopsydVaveformViewerwindow will appear
as shwn in Figure 6.
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Figure 6: The Synopsysateform ewer windav after a trace in_1 command.
(6) After tracing the desired signals, one may assames to signals with thessign command.
For example to set thealue of the signal in_1 taalue ‘1’ use the follwing command:
# assign ‘1'in_1
Similarly, we can assign thelue ‘1’ to input signal in_2 with the command:
# assign ‘1’ in_2
(7) Run the simulation for a period of 2 ns. Issue the command:
#run 2
The waveforms for the selected signals will be updated in theeform viever. To see the com-
plete wvaveform, select \w -> Full Fit from the Viveform windav top menu bar You can nw
assign ne values to the inputs, run the simulator for another time period awdivensy
results. Experiment with this method of assigniatyes and vieing results. Figure 7 shs the

resultsof thesimulationrun. You may print the simulationresultsto a Postscripfile by selecting
File -> Print . Select the File choice circle in the Primsé&ction and specify an appropriate file-

10
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name. Select Ok to print the file. Refer to the Appendix section for a printout of a sample simula-
tion session of thisVHDL model of asimpletwo-input and gate. This concludes thisintroductory
example.

|£i|e Edit Marker GoTo View Options Window Help
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Figure 7: The Waveform Viewer with some simulation results.
Example 2: Simulating a two-input and gate (using the command line interface)

This example uses the same and2.vhd file as the previous one; however the use of the command
linevhdlsim tool isillustrated. This method can be used when accessto agraphicsterminal isnot
possible.

(1) Analyze the file using vhdlan:
%vhdlan and2.vhd

(2) To invoke the Synopsys VHDL System Simulator (VSS) in command line mode use the com-
mand vhdlsim entity _name, where entity _name refers to the name of the entity in the VHDL
source file, for example and2_gate. When adesign is simulated with vhdisim, you control and
monitor the simulation by entering special Simulation Control L anguage commands at the sim-
ulator prompt which is represented by the # symbol. This example will illustrate the use of afew
basic Simulation Control Language commands.

ted@dea Code 4:48pm >vhdlsim and2_gate
Synopsys 1076 VHDL Simulator Version 3.4b



Copright (c) 1990-1995 by Synopsys, Inc.
ALL RIGHTS RESEED
This program is proprietary and confidential information
of Synopsys, Inc. and may be used and disclosed only as
authorized in a license agreement controlling such use
and disclosure.

# assign ‘1’ /and2_ae/in_1

# assign ‘1’ /and2_aje/in_2

#run 2

2 NS

# fprint “%r\n” /and2_ate/output

‘q

# assign ‘0’ /and2_aje/in_1

#run 2

4 NS

# fprint “%r\n” /and2_ate/output

‘0’

#quit

ted@dea Code 4:53pm >

Theassigncommands thesameasthatusedin graphicalmode.lt is usedto give asignalavalue.
Note hav the signhal names a been written: /and2ate/in_1, /and2_aje/in_2, /and2_aje/out-
put. In general Synopsysisesanamingcorventionvery similar thatthatemplo/edby the UNIX
file system. Names of VHDL objects are written in a hierarchasilibn bginning with the top
level entity. In this example,the nameof thetop level entity beingsimulateds and2_gte,hence
the full names of the signals in_1, in_2, and output declared within this entity are /ated2_g
in_1,/and2_gte/in_2, and /and2atg/output.

The fprint command is used to output tladue of an object. The format of this command is:
fprint “%format_specifier” agument
where format_specifier is one of:

b : the agument to fprintfis a single dimensioactor of type bit, output gen in binary

o : the agument to fprint is a single dimensioactor of type bit, output gén in octal

x : the agument to fprint is a single dimensioactor of type bit,, output gen in h&adecimal:
r: theargumentto fprint is aVHDL expression.Fprintwill printits valuein a“reasonable’form
c: the agument to fprint is a character literal

s: the agument to fprint is a string

d: the agument to fprint is an ingeer type, output will be gen in decimal format

e,f,g: the agument to fprintf is a floating-point type.

Within the format_string, you may represent certain non-graphic characters and the backslash \

12
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using the following escape sequences.

\n LF newline
\t HT, horizonta tab
W\ \, backslash

Other useful Simulation Control Language commands are:

step: used to single step through the VHDL source code line by line

next: similar to step except that it does not enter into functions or procedures

eval: used to print the value of any VHDL expression, handy for signals and variables

restart: used to restart the simulation and set the current value of simulation timeto O

interrupt: will interupt the simulation and return control to the user. Useful when your simulation
goes awry. It sometimes takes afew seconds to return control.

help: used to obtain more information on commands

Example 3: Using Command Files to control simulation.

Entering commands through the simulator prompt can be tedious, especialy if it necessary to
enter the commands a number of times. It is possible to store theses commands in afile and have
the simulator read and execute these commands from the file. The format for thisfileisasfollows:

comm file_name
command_1
command_2

command_n
end comm

This example illustrates the use of command files and also illustrates the use of a multi-level hier-
archical design style. Three separate VHDL source fileswill be analyzed, and the top-level entity
will make referencesto the the lower-level files. The two bottom-level files specify the entity-
architecture pairsfor an AND gate and a OR gate respectively.. Thetop-level entity consists of a
combinational logic circuit consisiting of two AND gates and a single OR gate.

(1) Create afile called tedand.vhd with the following contents:
entity ted _and is
port(A,B: in BIT; QUTPUT : out BIT);

end ted_and;

architecture ted arch of ted and is
begi n
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QUTPUT <= A and B after 5 ns;

end ted_arch;

(2) Create afile caled tedor.vhd with the following VHDL statementsin it:
entity ted or is

port(A,B: in BIT; QUTPUT : out BIT);

end ted or;

architecture ted arch of ted or is
begi n

QUTPUT <= A or B

end ted_arch;

(3) Create afile called tedcircuit.vhd with the following contents (thiswill be our top-level entity):
entity tedcircuit is

port(A,B,CD: inBIT, E: out BIT);

end tedcircuit;

architecture ted _arch of tedcircuit is

-- declare the conponents found in our entity
conmponent ted_and

port(A, B : in BIT, QUTPUT : out BIT);

end conponent;

conmponent ted_or

port(A,B: in BIT, OQUTPUT : out bit);

end conponent;

-- declare signals used to interconnect conponents
signhal sl1, s2 : BIT;

-- declare configuration specification

for UL, U3 : ted and use entity WORK ted_and(ted_arch);
for U2: ted or wuse entity WORK. ted_or(ted_arch);

begi n
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Ul : ted_and port map(A=>A,B=>B, OUTPUT =>s1);
U2 :ted_or port map(A=>C, B=>D, OUTPUT =>s2);
U3 :ted_and port map(A =>s1, B =>s2, OUTPUT => E);

end ted_arch;

(4) Note how the entity tedcircuit (whose architecture is specified in the file tedcircuit.vhd) makes
references to entities whose architecture is specified in a separate file. Specificaly, the two com-
ponents ted_and and ted_or are specified in two separate files. The rules specifying the order of
compilation of VHDL units require that the two files tedand.vhd and tedor.vhd be compiled prior
to the compilation of the file tedcircuit.vhd. We would analyze these three files in the following
order:

% gvan tedand.vhd
% gvan tedor.vhd
% gvan tedcircuit.vhd

(5) Create afile called tedcircuitstimulus which contains the following:
comm tedtester

trace /tedcircuit/a
trace /tedcircuit/b
trace /tedcircuit/c
trace /tedcircuit/d
trace /tedcircuit/s1
trace /tedcircuit/s2
trace /tedcircuit/e

assign ‘1’ /tedcircuit/a
assign ‘0’ /tedcircuit/b
assign ‘1’ /tedcircuit/c
assign ‘1’ /tedcircuit/d

run 10

assign ‘0’ /tedcircuit/a
assign ‘1’ /tedcircuit/b
assign ‘0’ /tedcircuit/c
assign ‘0’ /tedcircuit/d

run 10
assign ‘1’ /tedcircuit/a

assign ‘1’ /tedcircuit/b
assign ‘1’ /tedcircuit/c
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assign ‘1 /tedcircuit/d
run 10
end comm

(6) Invoke the vhdldbx debugger and select the TEDCIRCUIT__ TED_ARCH design and select
OK.

(7) From the VHDL Debugger window enter the following from the simulator prompt:

# include tedcircuitstimulus
# tedtester

(8) The ssimulator will open the Waveform Viewer window (since the command file included a
trace command) and will execute the commands contained in the file tedcircuitstimulus. See the
results of the simulation on the next page.

(9) At this point you may be wondering why it is necessary to specify signal names using the
arcane format of top_level _entity name/signal_name. Thereason for thisisthat asthe simulation
proceeds, the simulation tools traverse the hierarchy. In the parlance of Synopys, The Current
Working Region changes as the simulation proceeds. Observe the VHDL Debugger window after
issueing the commands listed in step 7 (see Figure 8). The source code window now lists the
VHDL code for the entity-architecture of the ted_and gate. The Current Working Regionislisted
as/TEDCIRCUIT/U3/_PO. If one were to name signals without the full hierarchical path name,
the signal would not be found once the simulation proceeded. For example, try to assign the top-
level entity signal E avalue of ‘0’ from the simulator prompt:

#assign ‘0 e

The simulator is not able to find this signal, sinceit is now longer in scope. The following error
message is generated:

vhdlsim,575: E is not declared.
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entity ted_and i=
portiA, B ¢ in BIT & OUTPUT & out BIT:
end ted_and:

architecture ted_arch of ted_and is
begin

= FOUTPUT <= A and B after 5§ nz:

end ted_arch:
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Figure 8: Descending to another level of hierarchy during simulation.

(10) We will now explore various techniques used to navigate a hierarchical design. Even the
simplest circuitswill exhibit some hierarchy, it isuseful to move around through this hierarchy to
examine the values of signals, variables, etc which are contained in different parts of the design.
Thevhdldbx debugger makestraversing a hierarchical design very simple, the commands are very
similar to corresponding UNIX commands used to navigate throughout the file system (cd, pwd,
s).

Quit the current vhdldbx session, and restart it selecting the TEDCIRCUIT__ TED_ARCH
design. From the ssmulator prompt at the bottom of the debugger window type:

# pwd
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This command will report the which part of the circuit is currently in scope. In other words, pwd
returns the value of the CWR (Current Working Region). In this example, vhdldbx will report /
TEDCIRCUIT asthe CWR.

Use the Is command to obtain alisting of the available circuit elementsin this current working
region:

#ls
The following design elements are reported in the message window of the vhdldbx window:

A D U2 TED_OR
B E U3 S1
C Ul TED_AND S2

The TEDCIRCUIT top-level entity consists of thefivesignalsA, B, C, D, and E, three component
instantiation sttements labelled U1, U2, U3, two internal signals S1 and S2, and two components
named TED_AND , TED_OR.

Use the ls -t command to obtain alist of the available components and their associated type:

#ls-t
A IN PORT
type=BIT
B IN PORT
type=BIT
C IN PORT
type=BIT
D IN PORT
type=BIT
E OUT PORT
type=BIT
ul COMPONENT INSTANTIATION STATEMENT
U2 COMPONENT INSTANTIATION STATEMENT
U3 COMPONENT INSTANTIATION STATEMENT

TED_AND COMPONENT
TED_OR COMPONENT
S1 SIGNAL

type=BIT
S2 SIGNAL

type=BIT

Using Is with the -v option will print the value of all elementsin the current working region
(although not every design element will have avalue).
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#ls-v

A ‘o

B ‘o

C o

D ‘o

E ‘o

Ul (no value)
u2 (no value)
u3 (no value)

TED_AND (no value)
TED_OR (no value)
S1 ‘o

S2 ‘o

We have not yet run the simulator, these values are the initial values as set by the simulator. By
default elements of type “bit” areset to ‘0’ during the initialization phase of smulation. Run the
simulator (by including the tedcircuitstimulus file and running the tedtester command contained
init). Repesat thels-v command to obtain the values at the end of the simulation.

Let’s descend down into the hierarchy. Enter the command cd U1 from the simulator prompt.
Enter Isto find out which elements are available. Since U1 isacomponent instnatiation statement
which instantiates an instance of a TED_AND component, the available elements are the two
input signals A, B, and the output signal OUTPUT.

Note that one may only cd into elements which have another level of hierarchy below. It makes
no sense to cd into signals or component declarations. Attempting to do so will result in an error
message being generated.

To return up to the previous level of hierarchy, use the cd .. command.

Example 4: This example will use the same three VHDL files as the previous example; another
feature of the Synopsystool will be explored. Specifically, we will use the Synopsys Design Ana-
lyzer to create a schematic diagram showing the interconnection of the various components and
signalsin our top-level entity tedcircuit. Prior to using the Design Analyzer, it is necessary to
copy another Synopsys specific setup file to you Synopsys working directory. Thisfileisthe
.synopsys_dc.setup file (Synopsys Design Compiler setup file). The use of thisfile will be
explained in the Synthesis part of thistutorial. For the time being, issue the following commands
to copy thefileto your directory:

% cd
% cd Synopsys
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% cp /[CMC/ENVIFONMENT/.synopsys_dc.setup .
You may wish to change the line
designer = “&d Oluchawicz” ;

in the.synopsys_dc.setdje to reflectyour own name(suchas“K eith Richards”). Youmayalso
wantto copy the.synopsys_dc.setjbe to your Codedirectory Thiswill allow youto invokethe
Design Analyzer from your Code subdirectory and immediately obtain a listing of design, rather
than haing to move around your directory structure from within the Design AnalyZéis
exampleassumethatthereexistsacopy of the.synopsys_dc.setdjpe in your Codesubdirectory

and your current wrking directory is the Code subdirectory Rart 1l of this tutorial, we will

invoke the Design Analyzer from the Synopsys diregtbence there should be a gayf the
.synopsys_dc.setup file in this directory as well.

(1) Invoke the Synopsys Design Analyzer with the failog command issued from the UNIX
prompt (from your Code orking directory):

% design_analyzer &

The Synopsys Design Analyzer will appear in wméndon. See Figure 9 belo

=] Il

Figure 9: Synopsys Design Analyzer wimdo
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(2) From thiswindow, Select File-> Analyze. A new Analyze File window will appear as shown
in figure 10. From this window, select tedand.vhd from the file list and make surwe that the File
Foramt is set to VHDL. Select OK.

(3) Repeat the steps given in (2) to analyze the files tedor.vhd, and tedcircuit.vhd. Note the order

of analysis.

T

File Mame{s): Itedand‘uhqk

Directory: AhomestedYHILSTARTERSGUIDEChap3

-

fourand,vhd
fourandoconfig? ,vhd
fourandconfig,vhd
half_adder,whd

integer,whd

RCA4_BEHAVE, whd

tedand, whd

tedcircuit?, vhd
7

tedcircuit,whd
tedor, vhd
test_struct,vhd

- |-

File Format: WHIL —

Librarys: INDRK

= | DEFALLT
J WORkK
7
- |-
- Create Mew Library if it Doesn't Exist
0K | Cancel I

Figure 10: Analyze File window.

(4) From the Synopsys Design Analyzer window select File -> Elaborate. The Elaborate Design

window will appear asillustrated in Figure 11. Select Default from the list of librarieslisted in

the top part of theform. A list of designswill then appear. Select tedcircuit(ted_arch) from asthe

Design and select OK.
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Librarys | DEFALLT

B MEFAULT
W01
# | woz

] ]

tedoircuit2ited_arch?

5
ted_and{ted_archl
ted_or{ted_arch
tedocircuiti{ted_archk
I

= T

FParametersi I

I Re-Analyze Out-0f-Date Libraries

Ok I Cancel I

Figure 11: Elaborate Design Window.
(5) The central portion of the Design Analyzer window will now contain three yellow sguares.
These icons correspond to the entities which were analyzed. Use the left mouse button to click on
theicon labelled tedcircuit.vhd. It will now be outlined with a dashed line. Select the down arrow
button located on the bottom left hand side of the window; a new icon will appear in the central
portion. There are four input portslabelled A, B, C, and D on the left hand side and a single out-
put port labelled E. This represents the symbol view of the entity tedcircuit. (See Figure 12)

=] il

Setup File Edit Yiew Attributes Analyzis Tools

Middle Button: Add/Modify Select - Right Button: Menu

Figure 12: Design Analyzer window with symbol view of entity tedcircuit.
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(6) Left click on the button labelled with the symbol for an AND gate located third from the top
on the left hand side of the Design Analyzer window. The top-level icon isnow replaced with a
schematic representation of the VHDL code (see Figure 13). Use the View -> Zoom In to zoom
in. Select one of the blue wires (which reprsent signals) with the left mouse button. The corre-
sponding signal name listed in the field named Net located at the bottom left hand corner of the
window.

Explore traversing the design hierarchy by selecting icon rectangle labelled ted_or and then
selecting the down arrow. The symbol for theted or entity is shown with the two input ports and
single output port. Thisisthe bottom of the hierarchy; it is not possible to descend further. Note
that the down arrow key is shown as not selectable in the window. To go up in the hierarchy, use
the up arrow key, thiswill return you to the tedcircuit entity.

=] il

Setup File Edit Yiew Attributes Analysis Tools

ted_and

ted_and

Current Design: tedcircuit Schematic View

Left Buttoni Select - HMiddle Button: AddAModify Select - Right Button: Menu

Figure 13: Schematic representation of the tedcircuit entity.
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PART Il : Logic Synthesiswith SYNOPSY S

In this section we will use the Synopsys tools to perform logic synthesis. In synthesis, VHDL
code will be trandlated into a netlist file. This netlist file can then be used as input to third-party
implementation tools. In thistutorial we will be using the Xilinx Alliance tool suite which will
perform the translation from netlist file into aworking design.

|. Setting up the technology libraries

At this point it is worthwhile to explain the purpose of the .synopsys_dc.setup file. The Synopys
synthesis tools require some basic information concerning the target technology. In our case, the
target technology is a Xilinx 4010e-3 Field Programmable Gate Array (FPGA). The -3 following
the part number refers to the speed grade of the device. A smaller number indicates a higher
speed device.

The .synopsys_dc.setup file which you have previously copied is already setup for a4010e-3
device. If you wish to target a different device, the five lines specifying the link_library,
target_library, define_design_lib, symbol_library, and synthetic_library must be replaced with
those given by the synlibs command. Synlibsis part of the Xilinx tool suite; it displays the Syn-
opsys link and target libraries that correspond to your choice of Xilinx part type/speed grade. In
addition, synlibs will display the symbol library and synthetic library if available. You can then
cut and paste these lines into your .synopsys_dc.setup file.

If you want to use the synlibs command, you must first set up your environment to run the Xilinx
tools. Issue the following command from the UNIX prompt:

% source /CMC/ENVIRONMENT/xilinx.env

Alternatively, you may copy thisfile to your directory and source it directly from there. Issuethe
synlibs 4010e-3 command to obtain the list of libraries:

ted@brownsugar ~/SYNOPSY S 3:07pm >synlibs 4010e-3

link_library = {xprim_4010e-3.db xprim_4000e-3.db xgen_4000e.db xfpga_4000e-3.db
xio_4000e-3.db xdw_4000e.5ldb}

target_library = {xprim_4010e-3.db xprim_4000e-3.db xgen_4000e.db xfpga_4000e-3.db
xio_4000e-3.db}

define_design_lib xdw_4000e -path XilinxInstall + /synopsy</libraries/dw/lib/xc4000e
symbol_library = { xc4000e.sdb}

synthetic_library = {xdw_4000e.dsldb standard.sldb}

Note: The XilinxInstall string in the define_design_lib definition should be replaced with the full
UNIX path to where your Xilinx tools areinstalled. This may vary as new versions are installed.
Check with your CAD tool administrator for the current location. For example, we currently have
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version 3.1i of the Xilinx Alliance toolsinstalled in the directory /CM C/tool s/xilinx.vM3.1i . This
means one should edit the define_design_lib entry to read as follows:

define_design_lib xdw_4000e -path /CM C/tool s/xilinx.vM 3.1i/synopsy</libraries/dw/lib/
xc4000e

II. Performing Logic Synthesis

This section will explain the use of the Synopsys tools used to perform logic synthesis. We will
primarily explore the use of Design Compiler shell scripts. These are ASCII text files which are
invoked from the command line with the dc_shell command. The other alternative is the use the
Synopsys Design Analyzer to perform synthesis using the graphical user interface. Shell scripts
are convenient in that they do not require access to agraphicsterminal, they may be executed over
amodem connection at one's convenience. You will find that afew simple changes to an existing
script will allow you to synthesize adifferent design. Most of the commands are the same, all that
is necessary isto change some of your input file names and output file names.

If you have not yet done so, source the synopsys.env file to set up your environment to allow you
to run the dc_shell command. You will also have to create a new directories in your Synopsys
directory as explained below.

(1) From your Synopsys directory create a subdirectory Synthesized and a subdirectory called
XNF. The Synthesized directory will hold the results of the synthesis procedure in a Synopsys
database (db) format. The XNF directory will contain the Xilinx netlist files generated by the
synthesis procedure. Create a subdirectory called Scripts; thiswill be used to hold the various
shell scripts we will be writing. These steps may be performed by issueing the following UNIX
commands:

% cd (thiswill return you to your home directory)
% cd Synopsys (change to your Synopsys directory)
% mkdir Synthesized

% mkdir XNF
% mkdir Scripts

(2) We will be executing the dc_shell command from the Synopsys directory. Our shell scripts
will be analyzing VHDL files, to avoid having our Synopsys directory cluttered up intermediate
work fileswe will tell Synopsysto store any intermediate files generated in the ./Code/Work
directory. Create afile called .synopsys_vss.setup in the Synopsys directory with the following
contents:

WORK > DEFAULT
DEFAULT: ./Code/Work
TIMEBASE = NS

Although it is not essentially necessary to have thisfile, it will avoid having intermediate files
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stored in the main Synopsys directory.
Example 1: Synthesizing a half-adder circuit.

(1) Change into your Code directory and create afile called half_adder.vhd with the following
contents:

library IEEE;
use ieee.std_logic_1164.all;

entity half_adder is
port (inl, in2: in std_logic;
carry, sum : out std_logic);
end half_adder;

architecture concurrent of half_adder is

begin
carry <= not (in1 and in2); -- active low outputs
sum <= not (inl xor in2); -- for board

end concurrent;

(2) Change into your Scripts directory and create afile called half_adder.scr with the following
contents:

[* Script to analyze and elaborate */
/* half adder using concurrent assignments  */
/* Ted Obuchowicz */

analyze -format vhdl ./Code/half_adder.vhd

elaborate half_adder

set_max_area 0

current_design half_adder

set_port_is_pad “*"

insert_pads -verify -verify_effort low

compile -map_effort high -verify

write -format db -hierarchy -output ./Synthesized/half_adder_before_replace_fpga.db

[*replace the CLBs and I0Bs with gates */

replace_fpga;

[* set part number */

set_attribute half_adder “part” -type string “4010epc84-3”
/* add pin locations */

set_attribute “in1” “pad_location” -type string “P19”
set_attribute “in2” “pad_location” -type string “P20”

set_attribute “carry” “pad_location” -type string “P61”
set_attribute “sum” “pad_location” -type string “P62”

/* write to a .db post replace fpga */
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wite -format db -hierarchy -output ./Synthesized/ half_adder.db
wite -format xnf -hierarchy -output ./XNF/ half_adder. xnf
quit

Let'stake afew minutesto explainthisscript file. Thefirst three lines are examples of comments.
Comments are enclosed in the /* and */ delimiter pairs. The next line analyzes the input file
found in the ./Code/half_adder.vhd directory. Note: this script was meant to be executed from the
Synopsys directory, the . in the filename is UNIX shorthand for the present working directory.
This example consists of asingle VHDL source file; scripts written for designs which consist of
multiple source files should analyze the files one by one from the bottom up.

The elaborate half _adder line builds the specified design from the intermediate files stored in the
work library. The design name is specified as the top-level VHDL entity, in this case the entity
nameishalf_adder. Recal, all theintermediate files are stored in the ./Code/Work directory. The
tool must know where to look for these intermediate files, hence the need for the

.synopsys vss.setup filein the directory from which the dc_shell command was invoked from. |If
there were no setup file in this directory, the tool would store any intermediate filesin this direc-
tory and would know to look there for them when it came time to elaborate the design.

The set_max_area 0 line tells the compiler to create a design which will be optimized for the
smallest possible size.

The next line current_design half_adder tells the Design Compiler that the following commands
should apply to this entity name.

We want to have all the portsin the top-level entity (half_adder) to be associated with input/out-
put pads of our target architecture. The set_port_is pad “*” command will tell the Design Com-
piler that all the portsin the top-level entity half_adder are to have I/O pads attached to them. The
actual pads will be inserted by the insert_pads command which follows.

Theinsert_pads -verify -verify_effort low command will add a XILINX Input/Output Block
(IOB) to each port which has had the port_is _pad attribute set on it by a preceding

set_port_is pad command. The -verify -verify _effort low tells the Design Compiler to perform a
functional comparison between the initial design and the padded result without spending too
many CPU cycles doing so.

The compile command performs logic and gate level synthesis on the current design.

The next command tells the Design Compiler to store the result of the synthesisin a special Syn-
opsys database format in the ./Synthesized directory with filename

half_adder before replace fpga.db. At thispoint, our synthesized design will consist of Xilinx
|OBs and CLB’s (Configurable Logic Blocks).

Thereplace fpgacommand is used to replace field-programmable cellsin the current design with
logic gates contained in the target library.

Therest of the script then tells the compiler which device we are targetting, associates the ports of
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the entity with actual device pin numbers, writes out the gate-level synthesized designto a
half_adder.db file in the Synthesized directory, generates a Xilinx netlist file with name
half_adder.xnf, and finally quits. Don’t concern yourself too much with how the pin numbers
were chosen; thisinformation isgiven in Part I11 of thistutorial.

The next step isto run the script using the dc_shell command.
(3) Change into your Synopsys directory and invoke the command
% dc_shell -f ./Scripts/half_adder.scr

Thiswill invoke the Design Compiler shell and execute the commands contained in the
half_adder.scr file. The Design Compiler will run and periodically report its progress. Make sure
that it terminates without any errors. If there are errors, check your half _adder.scr file for possible
typing errors etc.

(4) We will use the Design analyzer to examine the pre and post replace _fpga synthesis results.
type design_analyzer from the Unix command (enter thiscommand from the Synopsysdirectory).
Select File -> Read from the top portion of the Synopsys Design Analyzer window. The Read
File window will appear as shown in Figure 14. From this window, left click on the Synthesized
directory in the central portion of the window. After doing so, the Synthesized/ directory will
appear in the File Name(s) field. Move the cursor to the right of this name and left click the
mouse. Pressthe Return key on the keyboard. The scroll window will now list the files found
your Synthesized directory (see Figure 15). Select half_adder_before replace fpga.db and select
the OK button.

File Name(s}:l Sunthesizedd

Directory: Ahomested SYNOPSYS

vof (Move up one directoryl
Codes

Maruals

Schematics

Scriptss

SHNFS
Synthesized/

[ |

I~ 1

File Format: DB —

Ok I Canicel I

Figure 14: Read File.

In the central portion of the Design analyzer window will be ayellow square labelled half_adder



29

(see Figure 16). Select this square with the left mouse button, it will become outlined in a dashed
line. Descend down the hierarchy by selecting the down arrow button, the symbol view of the
half_adder entity will be shown listing input and output ports (see Figure 17). Select the button
with the AND gate symbol, the schematic in terms of Xilinx IOB’s and CLBswill be shown. In
this design there are 4 IOB’s and one CLB (see Figure 18).

File Mameisi: | half_adder_befaore_replace_fpaa.dh,

Directory; shomested/SYHOPSY S Synthesized

H

count3vector,db
da_newboardocount.3, db
da_newboardcount3vector,db

full_adder,db

half_adder.db

half_adder_before_replace _fpga.db
£

labl.db
led.db
one_bit_adder,db
struct_mux, db

I~ T

File Format: DB —

Ok I Canicel I

Figure 15: Selecting a design.

Setup File Edit Yiew Attributes Analysiz Tools

half_adder

Designs View

Read AhomestedsSYNOPSYSSynthesized/half_adder_before_replace_fpga,.db

Figure 16: Half_adder entity.
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Figure 18: Schematic of half_adder in terms of Xilinx blocks.
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(5) Use the Design Analyzer to read in the half_adder.db file from the Synthesized directory.
Descend down the design hierarchy and view the schematic. What are the differences between
the two synthesized designs? You can see the effect that the replace_fpga command had on the
two results. The post replace fpga design now consists of a gate level schematic diagram. The
bufferslabelled IBUF and OBUF_S are input/output buffers added by the synthesistool. See Fig-
ure 19.
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Figure 19: Post replace fpga synthesis results for half_adder design.
Example 2: Synthesizing a structural VHDL design.

This example will introduce a new dc_shell command: uniquify. This command must be used
when working with structural VHDL which consist of multiple instances of similar components.
The example consists of afull adder circuit constructed from two half adders and an OR gate.
There is some additional code which serves to decode the SUM and CARRY _OUT signalsto
drive a 7-segment LED display. The result of the binary full addition is displayed in decimal on
the LED display.

(1) Create the following files in your Code directory:

(i) afilecalled half_adder regular_outputs.vhd with the following contents:



li brary ieee;
use ieee.std_logic_1164. all

entity half_adder is
port ( inl, in2: in std_| ogic;
carry, sum: out std_logic);
end hal f _adder;

architecture true_outputs of half_adder is
begi n

carry <= (inl and in2);

sum <= (inl xor in2);
end true_outputs;

(i) afile called full_adder.vhd with the following contents:

library ieee;
use ieee.std_logic_1164. all

entity full _adder is
port(carry_in, inputl, input2 : in std_| ogic;
output : out std_logic_vector(6 downto 0));
end full _adder;

architecture structural of full _adder is
-- declare a hal f-adder conponent

conponent hal f _adder
port ( inl, in2: in std_| ogic;
carry, sum: out std_logic);
end conponent;

-- declare internal signals used to
-- “hook up” conponents

signal sumout, carry_out : std_logic
signal carryl, carry2 : std_l ogic;
signal sum.i nt : std_l ogic;

-- declare configuration specification
-- NOTE: we want to use the half adder with true outputs
-- not the inverted ones we synthesized earlier!

for hal, ha2 : half_adder use entity WORK hal f_adder (true_outputs);

begi n

-- conponent instantiation

32
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hal: hal f_adder port map(inl => inputl, in2 => input2,
carry => carryl, sum=> sum.nt);

ha2: hal f _adder port map(inl => sum.int, in2 => carry_in,
carry => carry2, sum => sumout);

carry_out <= carryl or carry2

out put <= “0000001” when ( (sumout = ‘0") and (carry_out = '0") ) else
“1001111" when ( (sumout = “1") and (carry_out = ‘0") ) else

“0010010” when ( (sumout = “0") and (carry_out = “1') ) else

( (sumout = “1") and (carry_out =1") ) else

“0000110" when
“1111111"

end structural

Note the line containing the configuration specification. For each instance of the half _adder com-
ponent we want the tool to use the architecture which hasthe “true”’ (non-inverted) outputs. Note
how easy it isto select a particular architecture associated with an entity. VHDL allows an entity
to have more than one architecture associated with it. The configuration specification is a mecha-
nism whereby a particular architecture is chosen for a particular instantiation of a component.

(2) In your Scripts directory create afull_adder.scr file:

/* Script to analyze and el aborate */

/* full adder */

/* Ted Cbuchowi cz */

anal yze -format vhdl ./ Code/ hal f_adder_regul ar_out puts. vhd
anal yze -format vhdl ./Code/full_adder.vhd

el aborate full _adder

set_max_area O

current _design full _adder

uni qui fy

set _port_is_pad “*”

insert_pads -verify -verify_effort |ow

conpile -map_effort high -verify

wite -format db -hierarchy -output ./Synthesized/full_adder_before_repl ace_fpga. db

/*replace the CLBs and IOBs with gates */

repl ace_f pga

/* set part nunber */

set_attribute full_adder “part” -type string “4010epc84-3”
/* add pin locations */

set_attribute “carry_in” “pad_|l ocation” -type string “P19”
set _attribute “inputl” “pad_|l ocation” -type string “P20"

set_attribute “input2” “pad_|l ocation” -type string “P23”

set_attribute “output<6>" “pad_|l ocation” -type string “P49”
set _attribute “output<5>" “pad_|l ocation” -type string “P48”
set_attribute “output<4>" “pad_|l ocation” -type string “P47”
set_attribute “output<3>" “pad_|l ocation” -type string “P46”
set _attribute “output<2>" “pad_|l ocation” -type string “P45”
set_attribute “output<l>" “pad_|l ocation” -type string “P50"



set _attribute “output<0>" “pad_|l ocation” -type string “P51"

/* wite to a .db post replace fpga */

wite -format db -hierarchy -output ./Synthesized/full _adder.db
/* wite out the Xilinx netlist file */

wite -format xnf -hierarchy -output ./XNF/ full_adder.xnf

quit

This script issimilar to the half_adder script. The main differenceisto use of the uniquify com-
mand. This command is used to Removes multiply-instantiated hierarchy in the current_design
by creating a unique design for each cell instance. It does this by appending an integer to the com-
ponent name for every instantiation statement in the source code. The uniquify command may
represent a substantial amount of total execution time during synthesis. For this reason, try to
keep structural VHDL only in your top-level entity.

(3) Execute the full_adder script from the Synopsys directory by entering:
% dc_shell -f ./Scriptg/full_adder.scr
(4) Invoke the Design analyzer and read in the full_adder_before replace fpga.db synthesized

design. Notice how each instance of the half_adder component has been “uniquified”; each
instance has been given aunique name: half_adder 0 and half_adder 1. See Figure 20.

1 F 1 F 1
full_adder half_adder_B half_adder_l

Figure 20: Uniquified full_adder design.

(5) Descend down into the hierarchy of the half_adder 0 component by selecting it and using the
down arrow button. Notice how this component isimplemented in asingle Xilinx CLB. The
half_adder_1 component is similarly implemented.

(6) Return to the top-level (use the up arrow button) and descend down into the full_adder hierar-
chy. Notice how it consists of IOBs, CLBs, and two half_adder components. See Figure 21.
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Figure 21: Full_adder schematic in terms of Xilinx blocks.

(7) Usethe Design Analyzer to examinethefull _adder.db synthesized design. Thisistheresult of
synthesis after FPGA cells have been replaced with gates form the technology library. Select
File -> Read -> Synthesized/full_adder.db and descend down the hierarchy of this design.
Traverse down the the gate level schematic (see Figure 22). Notice how each of the IOB in Figure
21 have been replaced with either an IBUF or an OBUF_S. Notice also that the two half adders
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are represented by yellow sguares. You can descend down into the hierarchy of either half_adder
by selecting it (it’s outline will change from a solid line to a dashed line) and sel ecting the down
arrow button of the Design Analyzer. Notice how the gate-level schematic of each half adder does
not have inverted outputs. Finally, we can see that the two CLBsin the middle of Figure 21 have
been replaced with a combinational logic network.

OpUF_S
R = D output<n:

DRUF_S
W >——i
ORUF_S
BLF 1
frputi[To—— ) s _I>__*m”m,

hia f_adderid ORLE S
B : ..
Inputz [P i hE. f_adderd-lg QR L~ nutpu1<a>
BLF - ORUF _5
F\ AND
==l > : ) L%
I
Aéo_J lpgfc_B oRES
PET" L nﬁpjl(i}
R DRUF_S N
EN\" L nutput B}

Figure 22: Full adder schematic after replacing FPGA cells with gates.

Example 3: 3-bit binary counter.

This example synthesizes a 3-bit binary counter. The script fileillustrates the syntax adopted by
Synopsys for naming elements of vectors. It also introduces anew command: report_fpga. This
command isissued prior to the replace fpgacommand. The report_fpga command is used to gen-
erate areport about FPGA resource usage. Xilinx cell information includes CLB and |OB statis-
tics, aswell as information about other cell resources. For CLBs, the number of F, G and H
function generators are listed as well as the number of CLB’s. 10 information includes number of
ports, number of Clock Pads (such as BUFGS cells), and the number of 10B cells used.
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(2) Inyour Code subdirectory create afile called count3_vector.vhd with the following contents:

library ieee;
use ieee.std logic 1164. all
use ieee.std | ogic_unsigned. all

entity count3 is

port( clk, resetn, count_en : in std_|ogic;
sum . out std logic vector(2 downto 0);
cout . out std logic);

end count 3;

architecture rtl of count3 is
signal count : std _|ogic_vector(2 downto 0);

begi n
process(cl k, resetn)
begi n
if resetn = 0" then
count <= (others => ‘0');
elsif clk’event and clk = ‘1" then
if count_en = ‘1" then
count <= count + 1,
end if;
end if;

end process;

sum <= not count; -- invert the outputs for the denp board
-- since its LEDs are active | ow

cout <= ‘0’ when count = 7 and count_en = ‘1" else ‘1

end rtl;

(2) Inyour Scripts directory, edit afile named count3_vector.scr with the following commandsin
it:

/* Script to analyze and el aborate */
/* 3 bit counter */
/* Ted Obuchowi cz */
/* VHDL file uses std_|logic_vector */

anal yze -format vhdl ./ Code/count3_vector.vhd

el aborate count3

set_max_area O

current_desi gn count3

set _port_is_pad “*”

insert_pads -verify -verify_effort |ow

conpile -map_effort high -verify

wite -format db -hierarchy -output ./Synthesized/ count3vector_before_replace_fpga. db
/* generate an FPGA resource usage report before replace_fpga */

report_fpga

/*replace the CLBs and 1 OBs with gates */



repl ace_f pga

/* set part nunber */

set _attribute count3 “part” -type string “4010epc84-3”
/* set the input-output pin |locations */

set_attribute “clk” “pad_|l ocation” -type string “P10”
set_attribute “resetn” “pad_|l ocation” -type string “P19”
set _attribute “count_en” “pad_|l ocation” -type string “P28”
set_attribute “cout” “pad_l ocation” -type string “P61”

set _attribute “sum<2>" “pad_l ocation” -type string “P58”
set _attribute “sunmkl>" “pad_l ocation” -type string *“P59”
set_attribute “sunk0>" “pad_|l ocation” -type string “P60”

/* wite to a .db post replace fpga */
wite -format db -hierarchy -output ./Synthesized/ count3vector.db

wite -format xnf -hierarchy -output ./XNF/ count3vector. xnf
quit

Note the use of the < and >, asirm<1>, to refer to indiidual elements of aector data type.
(this is actually controlled by theariable lus_naming_style in the .synopsys_dc.setup file)

(3) Use the dc_shell to run the count8ctorscr:
% dc_shell -f ./Scripts/count3egtorscr

After theelaboratecount3commands executedthe DesignCompilerwill reportthatit “inferred
memory degices”. This means the tool recognized the need for flip-flops in the synthesized
design. Since this desigras/a 3-bit binary counteB memory elements were inferred:

Inferred nmenory devices in process
inroutine count3 line 15 in file
‘/ horre/ t ed/ SYNOPSYS/ Code/ count 3_vect or. vhd’

When the script reaches the reportajegmmand, the foll@ing will be listed in the winde
from which the script is)@cuting in:

khhkkkhhkkhhhkkkhhhkkhhhkdkdhhrhdhddhkhrhdhkxdhkxrhkx*
Report : fpga

Design : count3

Version: v3.4b

Dat e : Thu Jul 23 13:26:58 1998

ER R kR R R I R R R R kb O R
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Xilinx FPGA Design Statistics

FG Function Generators: 3
H Functi on CGenerators: 0
Nurmber of CLB cells: 3
Nurmber of Hard Macros and

O her Cells: 1
Nurmber of CLBs in

O her Cells: 3
Tot al Nunber of CLBs: 6
Nurmber of Ports: 7
Number of C ock Pads: 1
Nurmber of | OBs: 6
Nunber of Flip Fl ops: 3
Number of 3-State Buffers: 0
Tot al Nunber of Cells: 11

(4) Use the Design analyzer to view the two results ( before and after replace fpga). Can you
identify the fpga resources used? Figures 23 and 24 give the results of the synthesis.
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Figure 23: Count3 design before replace fpga.
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Figure 24: Count3 design after replace fpga.
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PART Il : Implementation using Xilinx Design Manager

The end result of the steps performed in the previous section was the creation of anetlist filein a
format known as Xilinx Netlist Format (XNF). An XNF fileisanetlist of basic logic gates. The
Xilinx CAD (Computer Aided Design) tools use the XNF file asinput. The steps involved to
arrive at a functioning implementation beginning with an XNF file are summarized bel ow:

(i) the XNF fileis converted into a netlist of Xilinx Logic Cells. This step isreferred to as tech-
nology mappingor partitioning . The mapping also attempts to perform some optimization
either in terms of the number of Logic Cellsrequired or timing requirements.

(ii) the next step isto placeeach of the Logic Cells generated from the mapping phase into a spe-
cific location within the target FPGA. Once the Logic Cells have been placed, they must be inter-
connected using the available wiring resources and switches within the FPGA. Thisisreferred to
asrouting.

(i) once adesign has been placed and routed, a configuration file is created which is used to pro-
gram the FPGA. The Xilinx CAD toolswill create afile with a .bit extension. Thisfileisthen
used to program the FPGA on the demonstration board via the serial port of the workstation.

|. Setting up the user emir onment to run the Xilinx Design Manager piogram

Prior to using the Xilinx tools, source the file/CMC/ENVIRONMENT/xilinx.env. Also note that
the current version (3.4b) of this tool only works with the Solaris 2.5.1 operating system (for ver-
sion 1998.08-1 and onwards of Synopsysthisisno longer aproblem) . To find out the version of
operating system running on your workstation, issue the UNIX command “uname -r":

ted@fbi ~ 12:34pm >uname -r
551
ted@fbi ~ 12:34pm >

uname will report 5.5.1 for Solaris 2.5.1 machines. If you are not logged onto a Solaris 2.5.1
machine perform the following:

% echo $DISPLAY (remember the name of the DISPLAY which will be reported)
% rlogin fbi (or use sshinstead of rlogin asit is more secure)
$ setenv DISPLAY name:0.0 (where name was the name reported by the echo command)

It will be necessary to source the xilinx.env file from the machine you performed the remote login
to.

The above steps are not necessary if you are using version 1998.08-1 or higher.



I. Implementing a Design with the Xilinx Design M anager

(1) create asubdirectory called Xilinx from within your Synopsysdiretory. Thisdirectory will be
used to hold the intermediate files produced by the Xilinx CAD tools. The .bit file created during
the configuration step will also be saved in this directory.

(2) Invoke the Xilinx Design Manager with the following command:

% dsgnmgr &

after some time the Design Manager window will appear as shown in Figure 25.

Note: As new versions of the Xilinx software are installed, the new windows may not appear

exactly the same asthose illustrated in thistutorial. Ask you lab demonstrator for assistanceif you
have trouble filling out the new forms.

File Design Tools Utiities View Help

»| Dj=la| o|w Bl& B ¥

For Help, press F1 |_|_|_/ﬂ

Figure 25: Xilinx Design Manager.

(3) Create anew Project by selecting File -> New Project from the Design Manager top menu bar.
The New Project window will appear (see Figure 26). In thiswindow fill in the following fields:

Input Design: /home/user_name/Synopsys/XNF/half_adder.xnf



Working Directory: /home/user_name/Synopsys/ Xilinx/halfadder

L eave the Comment field empty, it isoptional. Select the OK button. Be sure the substitute your
actual login namein place of “user_name” listed in the example given above.

Input Design: | Browse.._|
Work Directory; | Browse... |
Comment; |
QK | Cancel | Help

Figure 26: New Project window.

(4) The Design Manager window will now list anew project in the central portion of the window.
Select Design -> Implement from thiswindow. Select the required part (X C4010-3-PC84) by
clicking on the Select Button and filling in the Part Selector form as shown in Figure 28. To obtain
alist of possible choices, select the small button marked with atraingle to the left of the field.

Part; [><C4D1DE—3—PCE:4 Select...

Iveﬂ

Mew version name:

Mew revision name: |rev1

Run I Cancel I Options... Help

Figure 27 : Implement Form.
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Farmnily: |<CanooE | /] | K |
Cevice: [<Ca010E /| Cancel I
Package: [PCa4a ¥ Help |
Speed Grade: -3 j

Figure 28: Part Selector.

(5) From the Implement form, select the Options button at the bottom of the form. Fill out the
form as givenin Figure 29. We are interested in having only Configuration Data produced, leave
the other fields to their default values. Select OK from the Options form.

r Control Files

Cra—

Guide Design:

User Constraints: |

Browse.. |

rProgram Option Templates

Implementation:; |Defau|t

N Edit Template.. |

Configuration; |Defau|t

j Edit Template... |

rOptional Targets

I Produce Timing Simulation Data

I Produce Configuration Data

I Produce Logic Level Timing Report

I Produce Post Layout Timing Report

| Cancel Help
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Figure 29: Setting the Options form.

(6) Once you have set the options, select Run from the Implement form. The Flow Engine win-
dow will appear (see Figure 30) and show the progress of the four stepsinvolved in the implemen-
tation: Translate, Map, Placeand Route, Configure. Certain stages may take long to complete.
At the end of implementation, the Flow Engine will report that the design was succesfully imple-
mented. There should be afilecalled half_adder.bit in the Xilinx directory at this point. The next
step is to download the configuration file to the demo board and verify the working hardware.

(7) Save the half_adder project by selecting File -> Save Project from the Design Manager win-
dow.

NOTE: If you are using version M 1.5 of the Xilinx Alliance software it will be necessary to
change to default place and route effort level from 2 to 4 (or higher). From the above Options
form select Edit Template (next to the Implementation field in the Program Option Templates),
then select Place and Route at the top of the popup window. Change the dlider control from 2 to 4.
Click OK in each window to return to the Implementation window.

Flow “iew Setup Utilities Help

Wl =z BB S|
XC4000E Design Flow (revl) Status: OK
EI
b
0 B D B
Translate kap Flace&Route Configure
Running | [ |
reading XHF file "/home/ted/SYNOPSYS/SHHF/half_adder.xnf" ... A

Hriting HGO file "half_adder.ngo" ...
Launcher: "xnf?ngd" exited with an exit code of 0.

Reading HGO file "/home/ted/SYHOPSYS/Xilinx/halfadder/wverl/half_adder.ngo™ ...
Reading component libraries for design expansion...

-~

3] i
- | L | [~ | [ | |

For Help, press F1 [XC4010E-3-PC84 [None |Mone 4

Figure 30: Flow Enginein progress.

lIl. Do wnloading a design to the demonstration board



47

The Hardware Debugger will be used to download the bit file to the FPGA demonstration board.

Once downloaded, the hardware may be tested. Configuration datais retained in the FPGA only
aslong as power is applied to the board. Since the FPGA is alookup table architecture, any data
will be lost when power is turned off.

(1) At this point, you must be using a workstation which has the required X checker cable con-
necting the workstation’s serial port and the demo board. With the half_adder project still open,
select Tools -> Hardware Debugger from the Design Manager’s menu bar. The Hardware Debug-
ger window will appear as shown in Figure 31. An additional window will appear (see Figure 32)
with the notice that the design does not have aREADBACK block connected. Thisis normal.
Select OK in this window to continue.

File Edit View Download Debug Cable Window Help

DlslEl & 2] #[%v]¢] B =[=] &]ajala] ¥

For Help, press Fi Yehecker@3600 | 4

Figure 31: Hardware Debugger.
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Cesign does not have READBACK. block connected.
53 Verification and debug mode are disabled.

o]

Figure 32: Verification and Debug notice.

(2) The Hardware Debugger window will now list the current design (half_adder). Use the mouse
to highlight the half_adder.bit file listed under DESIGNS (see Figure 33). After selecting the bit
file, select Download from the top menu bar.

File Edit View Download Debug Cable Window Help

Dl(E] &f M #[#]v]e] B1¥| =[= QIR ¥

half adder bit

- o DESIGN

£ 4010EPCE4
o WAVEFORMS
& MACROS

For Help, press F1 Yehecker@3600  |Not configured |yncDebug 4

Figure 33: Selecting the half_adder.bit file for download.
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(3) A small window (see Figure 34) showing the progress of the device download will appear.
When the bit file has been transferred to the board, awindow will appear indicating the device
download is complete (Figure 35). Select OK in this window.

(4) You may now test the design using the demonstration board. Set the DIP switches (located in
the centre of the board) to different combinations and verify the Carry and Sum outputs as indi-
cated onthe LED bar display.

(5) Quit the Hardware Debugger (File -> Exit) and quit the Design Manager.

o
Diownloading block 12

50%

HERRRRRER
Cancel |

Figure 34: Device download progress window.

% Device is configured. (28.47 secs)

ok

Figure 35: Download complete window.
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PART 1V : Xilinx FPGA Demonstration Board

The Xilinx FPGA demonstration board (Figure 36) is used to program and testing Xilinx FPGAs
(XC3000 and X C4000 devices) using the Xilinx Alliance Series software (Design Manager).
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Figure 36: Xilinx demonstration board layout.

The board is populated with two Xilinx FPGAs: a X C3020A PC68 and a XC4010E PC84. In
addition to these programmable devices, the board contains a series of DIP switches, LED bar
indicators, and LED 7-segment displays. Note that the FPGA chips are volatile; they will need to
be reprogrammed every time the power supply to the bouard is turned off. The remainder of this
section describes the demonstration’s boards components used in programming and testing.

|. General Purpose Input Switches (SW?3)

This DIP switch provides 8 general purpose inputsto both FPGAs on the demo board. The switch
islocated vertically between the two FPGAs. When a switch isin the ON position (pressed
inwards towards the switch number on the right-hand side of the board), alogic “1” is applied to
the FPGA'spin. A logic “0" is applied when the switch isin the OFF position. Table 1 give the
pin connections for SW3.



Table 1:

SW3 Pin Connections

Switeh Pin n(;Jnmber Pin n(;Jnmber
SW3 | Xcao20a | XC4010E
1 11 19
2 13 20
3 15 23
4 17 24
5 19 25
6 21 26
7 23 27
8 24 28

Il. 7-Segment Display (U6, U7, UB

51

The XC4010E chip drives the two right most 7-segment displays. The left display is connected to
the XC3020A chip. These 7-segment display unitsare ACTIVE LO W. This means that the cor-
responding segment will be lit when alogic “0” isapplied to its pin number. The pin connections
for the three 7-segment displays are given in Table 2 and the segments of the display are shownin
Figure 37.

Table 2: Pin connectionsdr 7-segment displays

7-Segment | XC3020A XC4010E | XC4010E
Display U6 u7 us
a 38 39 49
b 39 38 48
c 40 36 47
d 56 35 46
e 49 29 45
f 53 40 50




Table 2: Pin connectionsfor 7-segment displays

7-Segment | XC3020A XC4010E XC4010E
g 55 44 51
decimal 30 37 41
point

Figure 37: 7-Segment display LED segments.
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The decimal point of the rightmost display (U8) is connected to pin 41 of the X C4010E and acts
asaprogramming error indicator. During programming of the chip, this decimal point should not
belit. If it comes back on, thisindicates a programming error. The decimal points of U6 and U7

are tied low during programming and are on when the FPGASs are waiting to be programmed.

[11. LED Bar Indicators (D1-D8, D9-D16)

There aretwo LED Bar indicators on the demonstration board. They arelocated on the right-hand
side of the board below the X C4010E chip. Thetop bar indicator is connected to the XC3020A,

the lower 8 LEDs are connected to the pins of the XC4010E. These LEDsareaso ACTIVE
LOW. Table 3 givesthe pin connections for the LED bar indicators.

Table 3: LED Bar Indicator Connections

. XC4010E
XC3020pin Bottom :
Top LEDs AUMbErs LEDs pin numbers
D1 37 D9 61
D2 36 D10 62
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Table 3: LED Bar Indicator Connections

TopLEDs | XC3020pin | - Botom | TC
D3 41 D11 65
D4 33 D12 66
D5 32 D13 57
D6 31 D14 58
D7 28 D15 59
D8 29 D16 60

V. Expansion | nput/Output

The Xilinx FPGA demonstration boards available in the lab have been modified by the ECE tech-
nical staff to include 8 additional DIP switch inputs and 8 additional BAR LED outputs. Tables 4
and 5 give the pin locations for the inputs and outputs respectively.

Table 4: Expansion DIP
Switch Inputs

XC4010E

SWITCH :
pin number

SW1
SW2
SW3
SW4
SW5
SW6
SW7
SW8

gwhmm\loom




Table 5: Expansion BAR
LED Indicators

LED | i umber
D1 83
D2 82
D3 81
D4 80
D5 79
D6 78
D7 77
D8 70

V. Moreinformation on the FPGA Demonstration Board

More information regarding the Xilinx FPGA demonstration board can be found using the
online Xilinx documentation. A hardcopy of Chapter 1 of the Hardware User Guideisincludedin
the Appendix for convenience. To invoke the online documentation, simply select the Help button
in any of the Xilinx windows.
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APPENDIX

This section contains a printout of Chapter 1 from the Hardware User Guide available through the
Xilinx on-line documentation.



